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preface


Data is everywhere, and it’s used in practically every industry in one way or another. One of the most common ways to interact with data, whether numbers or text, is with spreadsheet software. This approach offers several useful features: presenting data in a tabular view, allowing calculations to be performed using those values, and producing summaries of data. What spreadsheets don’t tend to provide is a way to do this repeatedly, reproducibly, or programmatically (without clicking or copying and pasting). Spreadsheets can be great for displaying data (including limited data summaries); but when you want to do something truly powerful with data, you need to go beyond them to a programming language.

Data munging—manipulating raw data—is a cornerstone of data science. Munging techniques include cleaning, sorting, parsing, filtering, and pretty much anything else you need to do to make data truly useful. They say 90% of data science is preparing the data, and the other 90% is actually doing something with it. Don’t underestimate how important it is to carefully prepare data; analysis interpretations hinge on getting this step right.

Using a programming language to perform data munging means the things you do to your data are recorded, can be reproduced from the raw source, and can be inspected later—even changed, if necessary. Trying to do this from a spreadsheet means either writing down which button to press when, or a broken link between output and input.

I love using R. It’s useful in many ways. I never thought a language could be so flexible that it could calculate a t-test one moment and then request an Uber the next. Every word of this book has been processed by R code; the inline results were generated by actual R code and brought together using a third-party R package (knitr). I use R for the vast majority of my work, both data munging and analysis, which over the years has varied from estimating fish abundances to assessing genetic factors in cancer drug trials. I could not have done any of these things if I was limited to working in a spreadsheet program.

Over the course of reading this book, you’ll learn enough of the ins and outs of the R programming language to be able to take the data you’re interested in and produce an analysis well beyond what you’d be able to accomplish with a spreadsheet.






NOTE  A message to those of you who have obtained a pirated copy of this book. Copyright infringement is commonly justified by those who partake in it by the notion that “no one loses anything.” That’s true. But only the infringer gains anything. Many, many hours went into the writing and publication of this book, and without a formal sale involved, any gain you receive from reading this book goes unnoticed and unappreciated. If you have an unofficial copy of this book and have found it useful, please consider buying a legitimate copy, either for yourself or for someone else you think might benefit from it. 
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about this book


Who needs this book?

You do, of course. Given that you’re reading this, I’m guessing that you have some data (stored as a spreadsheet, perhaps) and aren’t quite sure what to do with it. That’s fine; great, even. Maybe you want to learn something from your data. Maybe you want to find a new way to interact with it. Maybe you want to make a picture out of it. All great goals, but I’m also guessing you want to learn how to do some programming for the first time.

I’m not going to assume you know how to program already, or that you are familiar with the jargon. Perhaps you’ve already picked up a few programming books and been scared off by how fast they fly through the introductory material trying to get you up to speed on every nuance of the way that particular language works. Not here. We’ll take things slow and work on a lot of examples together so that by the time we get to the end you’ll be comfortable with doing what you want to do with your data.

I’m also not going to even mention statistics. That’s a topic for someone else to cover. If you don’t have a background in statistics, don’t worry; it’s not a requirement here. We’ll be looking at R programming, not statistics (which it, at least, is very good at).

By the time you’ve finished reading this book, you should have a broad understanding of programming and how you do it with the R language; how data can be investigated, interrogated, and used to gain insights; and how to set yourself up for a robust, reproducible workflow that uses data to strengthen your conclusions.

You’ll see how to take a small dataset and transform it into meaningful, publication-quality graphics with far more flexibility than any spreadsheet software can offer. With just a dozen commands, you can turn the data shown in figure 1 (the mtcars dataset already available from within R, as shown in the RStudio data viewer) into the graphic in figure 2.


[image: View_mtcars.png]
Figure 1 The mtcars dataset, available from within R, as viewed in the RStudio data viewer. This data was extracted from the 1974 Motor Trend US magazine, and comprises fuel consumption and 10 aspects of automobile design and performance for 32 automobiles (1973–74 models).





[image: mtcars_3_gray.png]
Figure 2. This visualization of the mtcars dataset plots the mileage (mpg, as well as fuel consumption in transformed units) against the engine displacement (disp) of the 32 vehicles, grouped both by the number of cylinders (cyl) and distinguished by their transmission (am), along with a linear fit to each cylinder group’s data. This is achieved, formatting and all, in just a dozen lines of R code.




How to read this book

I present each chapter to you in a no-nonsense manner; I cover what’s important and what’s likely to become an issue if you’re not careful. I can’t cover every way to approach a problem, and I may not do it necessarily the same way that other texts approach problems. But I try to show you what I consider to be the best approach first and back that up with some alternatives that you may be likely to also encounter in other reading. The goal here is to make you a competent and productive R user, which may mean showing you how to do things the slow way (as well as the fast way).

Formatting

New terms and definitions are shown in italics when they are first mentioned. Code samples and data values are printed in a monospace font, either inline (for mentions of code) such as str(mtcars) or in code blocks for examples you should try yourself, such as this one:

myData <- head(mtcars, n = 2)


When a code sample produces output, this is shown below the input with the prefix #> and you should generally expect to see the same if you run the code yourself. The output for the vast majority of examples has been generated by R itself in the course of writing this book. Don’t worry if you try to run the lines starting with #>; they will be ignored by R:

myData
#>               mpg cyl disp  hp drat    wt  qsec vs am gear carb
#> Mazda RX4      21   6  160 110  3.9 2.620 16.46  0  1    4    4
#> Mazda RX4 Wag  21   6  160 110  3.9 2.875 17.02  0  1    4    4


Options that are available via a menu appear as a sequence of selections to make, such as File > Save > OK. And I tell you plainly which buttons to click and which keys you need to press.

Examples are sometimes shown as blocks of annotated code, like this, which reads some data from a .csv file and calculates the average height value:

peopleData <- read.csv(file = "people.csv")           ①  
summary(peopleData)                                   ②  
mean(peopleData$height)                               ③  


①  Reads the data from the .csv file into a data.frame


②  summary() acting on a data.frame returns a column-wise 5-number summary.


③  You can take the mean() of a column of values.


Certain kinds of information are highlighted along the way:






Note  When a piece of information is particularly critical or important, it will be presented in a block like this one. Such blocks also indicate additional information, historical curiosities, or other notes. 













Caution  R won’t always stop you from doing something you didn’t intend. In fact, sometimes it will seem to be actively trying to catch fire. Where fires are easily started, they’re pointed out like this to help you avoid them.













Tip  There are typically many ways to solve a problem using R, and I only discuss the simplest in any detail here. Where a better solution exists (but requires more information), I note it like this and try to give you enough information to go find out more yourself.








In some cases, code blocks are not accompanied by output, because the code does not actually run. These code blocks are for illustration purposes only. Where output is shown, you should expect to get similar results when you run the code. 

Errors produced by R begin with the word Error. You’ll see lots of these in the code in this book. The precise wording of the error may differ slightly between versions. Please take care when entering blocks of code containing one of these errors, as that output cannot be parsed by R.

Throughout the book I’ll also show you what a spreadsheet equivalent starting point might look like. I will use LibreOffice, which looks like figure 3, but the concepts will usually extend to Excel, Google Sheets, or whichever spreadsheet software you usually use.


[image: libreofficeexample.png]
Figure 3 An example of cells selected in LibreOffice (Linux)




Structure

As we progress through the book together, there will be lots of examples that I hope you will work through. Don’t just read them—run them on your computer yourself and see if you get the same answers. Then try a variation on the example and see if you get the result you expect. If you get something different, that’s great! It means you’ve found something to learn from, and your next task will be to understand why the result is what it is.

I will try to progressively build up your knowledge of the relevant programming and R-specific terms, so don’t be afraid to go back and revise if something seems unfamiliar.

Getting started

Here's what you will need:


	This book

	A computer

	A desire to learn something



Really, that’s about it. R is a free (as in speech—openly available—and as in beer—it costs nothing) language, and we’ll be using more free software to interact with it. You will probably need an internet connection to download the (free) software, but after that the majority of examples will work offline.

Follow along with the examples as they appear. Try different values and see if you get the result you expect. Break things and try to understand what happened. It’s very difficult to end up in a situation that can’t be resolved by restarting R, so feel free to experiment.

This book won’t necessarily direct you toward how to solve your specific problems, but it should give you enough of a comprehension of the language and its ecosystem for you to begin working out what other tools you might need to use. If you’re working in genomics, there’s a good chance you’ll need some more advanced tools provided by the Bioconductor suite of packages: www.bioconductor.org. Many of the concepts and structures used there extend from those you’ll learn about in this book (though I don’t cover those here).

Where to find more help

Stack Overflow (https://stackoverflow.com) is an immensely useful source of information under the r tag, but it’s frequently overrun with poorly researched questions and thankless responses. Take the time to figure out if your question has already been answered (which happens regularly, given how many questions have been asked) before insisting that someone else solve your problem.

If all else fails, typing what terms you do know and r or rstats into a search engine (such as Google) tends to produce some useful results more often than not.

The R Weekly site (https://rweekly.org) provides a weekly summary of the most interesting R posts from around the web. R-bloggers (https://r-bloggers.com) provides a syndication of many popular R-related blogs and has fresh content daily. Follow along with some of these that align with your interests, and you’re bound to come across some useful tips.

Finally, reach out to your local community, either in person (try https://meetup.com) or online (Twitter, #rstats).

More about this book

This book was written in the AsciiDoc plain-text markup language using emacs and RStudio. The R code herein was evaluated using a custom package library defined via the switchr R package and intertwined among the source using the knitr R package.

The session information describing the environment defining this custom library is as follows:

#>  setting  value
#>  version  R version 3.4.3 (2017-11-30)
#>  system   x86_64, linux-gnu
#>  ui       X11
#>  language en_AU:en
#>  collate  en_AU.UTF-8
#>  tz       Australia/Adelaide
#>  date     2018-01-23
#>
#>  package     * version  date       source
#>  assertthat    0.2.0    2017-04-11 CRAN (R 3.4.3)
#>  backports     1.1.2    2017-12-13 CRAN (R 3.4.3)
#>  base        * 3.4.3    2017-12-01 local
#>  bindr         0.1      2016-11-13 CRAN (R 3.4.3)
#>  bindrcpp      0.2      2017-06-17 CRAN (R 3.4.3)
#>  broom         0.4.3    2017-11-20 CRAN (R 3.4.3)
#>  cellranger    1.1.0    2016-07-27 CRAN (R 3.4.3)
#>  cli           1.0.0    2017-11-05 CRAN (R 3.4.3)
#>  colorspace    1.3-2    2016-12-14 CRAN (R 3.4.3)
#>  commonmark    1.4      2017-09-01 CRAN (R 3.4.3)
#>  compiler      3.4.3    2017-12-01 local
#>  crayon        1.3.4    2017-09-16 CRAN (R 3.4.3)
#>  crosstalk     1.0.0    2016-12-21 CRAN (R 3.4.3)
#>  curl          3.1      2017-12-12 CRAN (R 3.4.3)
#>  data.table    1.10.4-3 2017-10-27 CRAN (R 3.4.3)
#>  datasauRus  * 0.1.2    2017-05-08 CRAN (R 3.4.3)
#>  datasets    * 3.4.3    2017-12-01 local
#>  devtools    * 1.13.4   2017-11-09 CRAN (R 3.4.3)
#>  digest        0.6.14   2018-01-14 CRAN (R 3.4.3)
#>  dplyr       * 0.7.4    2017-09-28 CRAN (R 3.4.3)
#>  evaluate      0.10.1   2017-06-24 CRAN (R 3.4.3)
#>  forcats     * 0.2.0    2017-01-23 CRAN (R 3.4.3)
#>  foreign       0.8-67   2016-09-13 CRAN (R 3.3.1)
#>  ggplot2     * 2.2.1    2016-12-30 CRAN (R 3.4.3)
#>  glue          1.2.0    2017-10-29 CRAN (R 3.4.3)
#>  graphics    * 3.4.3    2017-12-01 local
#>  grDevices   * 3.4.3    2017-12-01 local
#>  grid          3.4.3    2017-12-01 local
#>  gtable        0.2.0    2016-02-26 CRAN (R 3.4.3)
#>  haven         1.1.1    2018-01-18 CRAN (R 3.4.3)
#>  here        * 0.1      2017-05-28 CRAN (R 3.4.3)
#>  hms           0.4.0    2017-11-23 CRAN (R 3.4.3)
#>  htmltools     0.3.6    2017-04-28 CRAN (R 3.4.3)
#>  htmlwidgets * 1.0      2018-01-20 CRAN (R 3.4.3)
#>  httpuv        1.3.5    2017-07-04 CRAN (R 3.4.3)
#>  httr        * 1.3.1    2017-08-20 CRAN (R 3.4.3)
#>  jsonlite      1.5      2017-06-01 CRAN (R 3.4.3)
#>  knitr       * 1.18     2017-12-27 CRAN (R 3.4.3)
#>  lattice       0.20-35  2017-03-25 CRAN (R 3.3.3)
#>  lazyeval      0.2.1    2017-10-29 CRAN (R 3.4.3)
#>  leaflet     * 1.1.0    2017-02-21 CRAN (R 3.4.3)
#>  lubridate     1.7.1    2017-11-03 CRAN (R 3.4.3)
#>  magrittr      1.5      2014-11-22 CRAN (R 3.4.3)
#>  mapproj     * 1.2-5    2017-06-08 CRAN (R 3.4.3)
#>  maps        * 3.2.0    2017-06-08 CRAN (R 3.4.3)
#>  memoise       1.1.0    2017-04-21 CRAN (R 3.4.3)
#>  methods     * 3.4.3    2017-12-01 local
#>  mime          0.5      2016-07-07 CRAN (R 3.4.3)
#>  misc3d        0.8-4    2013-01-25 CRAN (R 3.4.3)
#>  mnormt        1.5-5    2016-10-15 CRAN (R 3.4.3)
#>  modelr        0.1.1    2017-07-24 CRAN (R 3.4.3)
#>  munsell       0.4.3    2016-02-13 CRAN (R 3.4.3)
#>  nlme          3.1-131  2017-02-06 CRAN (R 3.4.0)
#>  openxlsx      4.0.17   2017-03-23 CRAN (R 3.4.3)
#>  parallel      3.4.3    2017-12-01 local
#>  pillar        1.1.0    2018-01-14 CRAN (R 3.4.3)
#>  pkgconfig     2.0.1    2017-03-21 CRAN (R 3.4.3)
#>  plot3D      * 1.1.1    2017-08-28 CRAN (R 3.4.3)
#>  plyr          1.8.4    2016-06-08 CRAN (R 3.4.3)
#>  psych         1.7.8    2017-09-09 CRAN (R 3.4.3)
#>  purrr       * 0.2.4    2017-10-18 CRAN (R 3.4.3)
#>  R6            2.2.2    2017-06-17 CRAN (R 3.4.3)
#>  Rcpp          0.12.15  2018-01-20 CRAN (R 3.4.3)
#>  readr       * 1.1.1    2017-05-16 CRAN (R 3.4.3)
#>  readxl        1.0.0    2017-04-18 CRAN (R 3.4.3)
#>  reshape2    * 1.4.3    2017-12-11 CRAN (R 3.4.3)
#>  rex         * 1.1.2    2017-10-19 CRAN (R 3.4.3)
#>  rio         * 0.5.5    2017-06-18 CRAN (R 3.4.3)
#>  rlang       * 0.1.6    2017-12-21 CRAN (R 3.4.3)
#>  rmarkdown   * 1.8      2017-11-17 CRAN (R 3.4.3)
#>  roxygen2    * 6.0.1    2017-02-06 CRAN (R 3.4.3)
#>  rprojroot     1.3-2    2018-01-03 CRAN (R 3.4.3)
#>  rstudioapi    0.7      2017-09-07 CRAN (R 3.4.3)
#>  rvest         0.3.2    2016-06-17 CRAN (R 3.4.3)
#>  scales        0.5.0    2017-08-24 CRAN (R 3.4.3)
#>  shiny         1.0.5    2017-08-23 CRAN (R 3.4.3)
#>  stats       * 3.4.3    2017-12-01 local
#>  stringi       1.1.6    2017-11-17 CRAN (R 3.4.3)
#>  stringr     * 1.2.0    2017-02-18 CRAN (R 3.4.3)
#>  switchr     * 0.12.6   2017-11-07 CRAN (R 3.4.1)
#>  testthat    * 2.0.0    2017-12-13 CRAN (R 3.4.3)
#>  tibble      * 1.4.1    2017-12-25 CRAN (R 3.4.3)
#>  tidyr       * 0.7.2    2017-10-16 CRAN (R 3.4.3)
#>  tidyverse   * 1.2.1    2017-11-14 CRAN (R 3.4.3)
#>  tools         3.4.3    2017-12-01 local
#>  utils       * 3.4.3    2017-12-01 local
#>  withr         2.1.1    2017-12-19 CRAN (R 3.4.3)
#>  xml2          1.1.1    2017-01-24 CRAN (R 3.4.3)
#>  xtable        1.8-2    2016-02-05 CRAN (R 3.4.3


Details for installing the specific versions of these packages are provided in appendix C. The code for the examples in the book is located at https://github.com/BeyondSpreadsheetsWithR/Book. There is also an issue tracker where people can link directly to the R code in which they find an issue: https://github.com/BeyondSpreadsheetsWithR/Book/issues. The source code is also available from the publisher’s website at www.manning.com/books/beyond-spreadsheets-with-r.

Book forum

Purchase of Beyond Spreadsheets with R includes free access to a private web forum run by Manning Publications where you can make comments about the book, ask technical questions, and receive help from the author and from other users. To access the forum, go to https://forums.mannning.com/forums/beyond-spreadsheets-with-r. You can also learn more about Manning’s forums and the rules of conduct at https://forums.manning.com/forums/about.

Manning’s commitment to our readers is to provide a venue where a meaningful dialogue between individual readers and between readers and the author can take place. It is not a commitment to any specific amount of participation on the part of the author, whose contribution to the forum remains voluntary (and unpaid). We suggest you try asking the author challenging questions lest his interest stray! The forum and the archives of previous discussions will be accessible from the publisher’s website as long as the book is in print.
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about the cover illustration


The figure on the cover of Beyond Spreadsheets with R is captioned “Habit of a Turkish Dancer in 1700.” The illustration is taken from Thomas Jefferys’ A Collection of the Dresses of Different Nations, Ancient and Modern  (four volumes), London, published between 1757 and 1772. The title page states that these are hand-colored copperplate engravings, heightened with gum arabic. 

Thomas Jefferys (1719–1771) was called “Geographer to King George III.” He was an English cartographer who was the leading map supplier of his day. He engraved and printed maps for government and other official bodies and produced a wide range of commercial maps and atlases, especially of North America. His work as a map maker sparked an interest in local dress customs of the lands he surveyed and mapped, which are brilliantly displayed in this collection. Fascination with faraway lands and travel for pleasure were relatively new phenomena in the late 18th century, and collections such as this one were popular, introducing both the tourist as well as the armchair traveler to the inhabitants of other countries.

The diversity of the drawings in Jefferys’ volumes speaks vividly of the uniqueness and individuality of the world’s nations some 200 years ago. Dress codes have changed since then, and the diversity by region and country, so rich at the time, has faded away. It’s now often hard to tell the inhabitants of one continent from another. Perhaps, trying to view it optimistically, we’ve traded a cultural and visual diversity for a more varied personal life—or a more varied and interesting intellectual and technical life.

At a time when it’s difficult to tell one computer book from another, Manning celebrates the inventiveness and initiative of the computer business with book covers based on the rich diversity of regional life of two centuries ago, brought back to life by Jeffreys’ pictures.







1

Introducing data and the R language




This chapter covers


	Why data analysis is important

	How to make your analysis robust

	How and why R works with data

	RStudio: Your interface to R



You have your data, and you want to start doing something awesome with it, right? Brilliant! I promise you, we’ll get to that as soon as we can. But first, let’s take a step back. Telling you to dive right in now would be like handing you a pile of different timbers, pointing you toward the workshop, and telling you to make some furniture. It’s a good idea to first understand both the materials and the tools you’re about to use.

We’ll go through what data means in general — to you and to those who may potentially inherit your data — because if you don’t fully comprehend what you already have, then building on that won’t be useful (and at worst will be flat out wrong). Poorly preparing data merely delays dealing with it properly and grows your technical debt (making things easier now, but later making it necessary to pay back that time when you have difficulties working with poorly formed data).

We’ll discuss how to set yourself up for a rigorous analysis (one that can be repeated) and then begin working with one of the best data analysis tools available: the R programming language. For now, let’s go through what it means to “have some data.”

1.1	Data: What, where, how?

I said you have some data that you want to do something with, which wasn’t a very precise statement. That was intentional. I guarantee you have some data even if you don’t realize it. You may be thinking that data is exclusively whatever is stored in your Excel file, but data is much more than that. We all have data, because it’s everywhere. Before you go analyzing your own data, it’s important to recognize its structure (both as you understand it, and as R will) so that you begin with a solid foundation of what it means to have some data.

1.1.1	What is data?

Data exists in many forms, not just as numbers and letters in a spreadsheet. It may also be stored in a different file type, such as comma-separated values (CSV), as words in a book, or as values in a table on a web page.






Note  It’s common to store comma-separated values in a .csv file. This format is particularly useful because it’s plain text — values separated by commas. We’ll return to why that’s useful in section 1.1.6.








Data may not be stored at all — streaming data comes as a flow of information, such as the signal your TV picks up and processes, your Twitter feed, or the output from a measuring device. We can store this data if we want to, but often we want to understand the flow as it’s happening.

Data isn’t always pretty (in fact, most times it’s dirty, mundane, and seemingly uninteresting), and it isn’t always in the format we want. Having some tools on hand to manage data is a powerful advantage and is critical to achieving a reliable goal, but that’s only useful if you know what your data represents before you do anything further with it. “Garbage in, garbage out” warns that you can’t perform an analysis on terrible data and expect to get a meaningful result. You may very well have tried to evaluate a calculation in Excel only to have the result show up as #VALUE! because you tried to divide a number by some text, even though that “text” looked like numbers. The types of your values (text, numbers, images, and so on) are themselves pieces of data with possible meanings behind them, and you’ll learn how to best make use of them.

So what is “good data”? What do the values you have represent?

1.1.2	Seeing the world as data sources

We experience the world through our senses — touching, seeing, hearing, tasting, smelling, and generally absorbing life around us. Each of those input channels handles available data, and our brains process them, mixing the signals together to form our picture of the world in a brilliantly complex way that we constantly take for granted.

Every time you use any of your senses, you’re taking a measurement of the world. How bright is the sun today? Is a car approaching? Is something burning? Is there enough coffee left in the pot for another cup? We construct measuring tools to make life easier for us and handle some of the data consistently — thermometers to measure temperatures, scales to measure weights, rulers to measure lengths.

We go a step further and create more tools to summarize that data — car instrument panels to simplify the internal measurements of the engine; weather stations to summarize temperature, wind, and pressure. With the digital age, we now have an overload of data sources at our disposal. The internet provides data on virtually any and all aspects of the world we might be interested in, and we create more tools to manage these — weather, finance, social media, the number of astronauts currently in space (www.howmanypeopleareinspacerightnow.com), lists of episodes of The Simpsons, all available at our disposal. The world is truly made up of data.

That’s not to say the data is in any way finite. We constantly add to the available sources of data, and by asking new questions we can identify new data we want to obtain. Data itself also generates more data. Metadata is the additional data that describes some other data — the number of subjects in a trial, the units of a measurement, the time at which a sample was taken, the website from which the data was collected. All these are data too and need to be stored, maintained, and updated as they change.

You interact with data in various ways all the time. One of the greatest achievements of the World Wide Web has been to gather, collate, and summarize our data for us in more easily digestible forms. Think about how you would have requested a taxi 20 years ago, before the rise of smartphones and the app ecosystem. You’d look up the phone number of a taxi company, phone them, tell the dispatcher where you were or would be, where you wanted to go, and what time you wanted to be picked up. The dispatcher would send out the request to all drivers, one of whom would accept the request. At the end of your journey, you’d pay with cash or a card transaction and receive a receipt.

Now, with the digital connections between devices, continuous internet access, and GPS tracking, that process simplifies to opening a ride-share app, entering your destination, and receiving a fare estimate, because your phone already knows where you are. The ride-share program receives this data and selects an appropriately close/available driver, exchanges your contact details in case anyone needs them, and routes the driver to you. At the end of your journey, your account is charged the appropriate amount, and a receipt is emailed to you.

In both cases, the same data flowed between all the parties. In the latter, fewer people needed to be involved because the computer systems have access to the relevant data. Your phone communicates with the ride-share server, your phone communicates with the GPS system to locate itself, and the ride-share server communicates with a payment server to authorize payment and the email server to send the receipt.

At every point along the way, various data can be collected (anonymously, where required) and saved for later analysis. How many people requested rides to the airport this month? What was the average distance travelled? What was the average wait time? Do people request more expensive trips from Apple or Android devices? Some of this was available previously, but it has never been easier to aggregate and compare.

Many businesses open up access to third-party developers using an application programming interface (API) so that the data can be more systematically accessed. For example, Uber has an API that allows software to ask for fare estimates or ride histories (with authentication, to approved accounts). This is how your phone app is able to communicate with the Uber servers. Sure enough, someone has written an R package to work with this API, meaning you can include data direct from Uber in your analysis, or (in theory) request a ride direct from R.






Note  Good software has a documented way to interact with it so that users and the software are able to communicate clearly and effectively. This can describe requests that can be sent to a server (and the expected responses) or just how a function should be used (and the expected return value).








1.1.3	Data munging

Data munging refers to the cleaning up and preparation of data. Most data collected isn’t ready to be used in an analysis or presentation. Usually there are inputs to validate, summaries to calculate, values to combine or remove, or restructuring to perform. This is a commonly overlooked aspect of using data for science, but it’s of vital importance. Failing to properly handle data can lead to difficulty working with it and, worse, incorrect conclusions drawn from it.

The terms data munging, data wrangling, data science, data analysis, data hazmat, and many others are all names for more or less the same thing, with different emphases and different trajectories depending on where the data is coming from or going to. Most analyses (be they elaborate, sophisticated regressions, or simple visualizations) begin with some form of data munging. Often that’s merely reading the data into software, in which case some of the handling is performed on your behalf with assumptions (these values are treated as dates, these as words, and so on). Having the power to control how that handling is performed can be essential when those assumptions are broken, or when you want to treat your data in a particular way.

Any time you have groups of records in your data, whether years, patients, animals, colors, vehicles, or anything else, and you need to treat them differently (color a line a certain way, only include records in an average of similar things, calculate how a quantity has changed between groups), you’ll perform data munging because you need to allocate records to a particular group somehow. Any other transformation, cleaning, or processing of the data also counts toward data munging. It quickly becomes apparent that a large portion of any analysis can (or should) involve a lot of data munging if its conclusions are to be trusted.

1.1.4	What you can do with well-handled data

I hope it’s clear by this point that data is potentially of great importance. It is routinely more than just numbers in a table. Medical data often represents real human lives and the effect a particular intervention has had, be that lifesavingly positive or tragically negative. These effects aren’t always immediately obvious to someone viewing them from a given perspective, so it’s the role of the data analyst (professional or incidental) to extract patterns from data in order to make a decision.

Analysis of data is often useful in extracting nonobvious patterns. For example, although you may recognize a pattern to the sequence

#>  2  4  6  8 10 12 14 16 18 20


(counting by twos), it may not be so clear what the pattern is in the following data

#>  0.000  0.841  0.909  0.141 -0.757 -0.959 -0.279  0.657  0.989  0.412


until you visualize the data (which was generated with a sin() function), as shown in figure 1.1. Having the right tools at hand to analyze our data means we can identify hidden patterns, forecast new information, and learn from the data.


[image: sin-1_updated.png]
Figure 1.1  A pattern emerges. These points were generated with a sin() function at the values 0, 1, …, 9. The smooth sin() function is also plotted here.




A classic example of data analysis is that of John Snow and the 1854 Broad Street cholera outbreak in London. People were dying by the hundreds within a particular district at a time when sewerage infrastructure was all but nonexistent and the understanding of infectious diseases was highly limited. By carefully examining the locations of the cholera cases, John Snow was able to infer that the common link between them appeared to be that their closest source of water was a particular pump on Broad Street. Once the pump was disabled, cases of cholera diminished significantly. In this case, the data was in plain sight — the locations of cholera cases — but the pattern and connection weren’t immediately apparent. See figure 1.2.


[image: snow.png]
Figure 1.2  The Broad Street Cholera Map, by John Snow (public domain), via Wikimedia Commons. Dots indicate pump locations, and cases of cholera are marked with stacked bars along streets.




Perhaps unsurprisingly, several R packages are available to interact with this data. The raw data can be found in the HistData package, and a further graphical analysis in the cholera package, resulting in figure 1.3.

Sometimes a spreadsheet program such as Excel or Libre Office is a sufficient tool for this purpose. Viewing some tabular numbers together, sorting them, and perhaps plotting them as a bar chart are all easily achieved in a wide range of software applications. When we want to interact with the data in a more structured, formal, reproducible, and rigorous manner, though, we turn to a programming language. R is an excellent choice.


[image: cholera_HistData_stacked.png]
Figure 1.3  Further analyses of the Broad Street cholera data produced using the HistData (top) and cholera (bottom) R packages




1.1.5	Data as an asset

Data is powerful, because data is information we learn from. We are rarely in a situation where we have no access to any data whatsoever (not just digital), but different data comes with different responsibilities.

Weather data is relied on by many to plan their day, be they fishermen figuring out how far they should venture from the relative safety of the shore, or a winegrower growing wine-making grapes planning the likelihood of overnight frost ruining their crop. Weather forecasts aren’t the rawest source of data but compiled summaries produced by digesting rawer sources of measurement.

Similarly, financial analysts provide assessments of the stock markets and insights into the likely day-to-day movements of critical investments. These too are generated from models that ingest high-frequency measurements of the current state of the market and provide higher-level summaries that are easier to grasp and act on.

In each of these cases, there are custodians of data who are relied upon: those who make available the raw measurements in a predictable and robust manner. Should these sources of data become corrupted, either the raw or processed sources, then those further down the chain are unable to provide reliable processing of that data, and there are potential consequences to follow. I would personally put a lot less faith in a weather report if I knew that the raw readings had been entered by hand into a spreadsheet and the forecast created by someone remembering in which order the buttons needed to be pressed, which cells needed to be copied over to another sheet, and which rows needed to be selected to be included in the calculation.

The motivation behind highlighting this fact will hopefully stay with you throughout this book — we are all part of a data chain, and if we don’t take care with the data while it’s in our possession, then all steps that follow are subject to failure in ways that won’t necessarily be apparent to those who query our data. We therefore seek to produce robust, reproducible, and transparent processing of any and all data we access and release back into the wild.

Although a thorough description of reproducible research requires significantly more resources to fully detail, the following guideline will serve you well for now:


	Document how, when, and from where you obtained your data.

	Provide commentary on any decisions you make during your handling of the data.

	Leave raw sources of data unchanged — anything you create along the way should be documented and reproducible, ideally without your involvement.








Tip  Reproducible research is key to trusting your results, even if they don’t seem to be of great significance. It may very well be only yourself looking at the results in a year, but knowing how you produced new data is just as important as what the data tells you.









Being able to trace back through the changes that a dataset has undergone is invaluable to justifying an analysis. You may end up with a plot of median income per capita for European countries, but can you tell how the scaling was performed from that? Was the data filtered for overseas income? Was the data a sample or a census? Without knowing what steps went into the analysis, the final result raises unanswerable questions.

It’s critical that any analysis you perform starts with the right data, data that’s collected in an appropriate manner and that addresses the question you’re asking. That question needs to be the right one too; otherwise you won’t learn what you’re hoping to.


Far better an approximate answer to the right question, which is often vague, than the exact answer to the wrong question, which can always be made precise.

—John Tukey, founding chairman of the Princeton Statistics Department



With the right data and the right question in hand, how do you go about keeping track of everything? For that, you need to be able to properly handle not just the data and the code, but how it changes over time.

1.1.6	Reproducible research and version control

Have you ever received a file with a filename like mydata_final_Thurs20May_phil_fixed_final_v2.xlsx? Not the most succinct name, but it hints at something much worse — that multiple copies of the file are floating around, each with a different version of the data, most of which is out of date due to some corrections or updates, and with unknown changes between versions. If someone presented a graph produced from one of these files, could you be certain which version it came from? Or if presented with the most recent graph and the one that preceded it, could you tell what had changed?

The answer is to not rely on the filename to store the versioning information (which it is poorly suited to do). Instead, version control systems (VCS) can keep track of the changes so that you (and any collaborators you are working with)


	Are always up to date with the latest version of all files

	Can review the changes between versions

	Can roll back to any previous version



Part of this is aided greatly by using plain-text files (such as .txt, .R, and .csv) because a version control system can literally compare the lines of two versions and show you what’s changed. Using binary files (such as .docx and .pdf) makes this more difficult to extract, but doesn’t make it useless:


	
Plain-text file — A file that stores its contents as numbers, letters, and punctuation, and as such can be opened in a text editor. Information in a plain-text file can be read into any system, and because it has no formatting, there’s no ambiguity about what each symbol represents or how to read it. This doesn’t preclude storage of formatting, but that too needs to be in plain text, such as a markup language that uses tags around values like <b>bold text</b>, or a markdown language that uses inline modifiers like **bold**.

	
Binary file — A file that stores its contents in binary (zeroes and ones) to be interpreted by suitable software. It’s not readable in a text editor but has the advantage that it can encode the formatting of data, including a variety of different formats including sounds, images, or video.



I won’t cover specific VCS options here, but you should find one that works for you. Some popular options include the following:


	Git (using GitHub/GitLab/Bitbucket)

	Subversion (also known as SVN)

	Mercurial



Each of those has a learning curve of its own but pays for itself the first time you need to undo a swath of changes or deletions.

Another great benefit of version control is that you can openly share (if you like) the code that describes what you’ve done with your data so that someone interested (possibly another data analyst, possibly yourself six months from now) can reproduce your work because they have the inputs and the analysis steps.

Have you ever completed working on some data and become worried that perhaps you haven’t saved your file, and that you might have to go through all those steps again (if you can even remember what they were)? If you can’t remember what steps you performed after just completing them, how can you trust that you did them correctly? How could someone else? By working with a script of commands, which you can think of as a log of exactly what you told the computer to do, you’re keeping a record of the analysis steps, and someone should be able to reach the same conclusions as you did if they start with the same data.

It’s not uncommon for data to require updates, and when that happens it’s easy to spot the difference between people who follow reproducible research methods and those who don’t. After weeks of data processing and number crunching, someone will notice that there was a typo in column 12 of the third data set and send out an updated file: data3_fixedTypo.csv.

The benefits of reproducible research are many. The person who doesn’t follow reproducible research does the following:


	Deletes all outputs (or saves them elsewhere)

	Opens up the new data file

	Performs all of the analysis steps as best as they can remember them

	Forgets that column 4 needs special treatment

	Doesn’t understand that the final results are more different than they should be



The person who follows reproducible research does the following:


	Changes the input data filename in their script

	Reruns the analysis script that contains all the required steps and their documentation

	Knows that the only thing that has changed this time is the input data update



Many R packages exist for helping us work within reproducible research frameworks, and we’ll talk about some of the more common ones later.

With our data at the ready, our questions screaming for answers, and our intentions focused on reproducible research through version control, the only thing we still require is a way to bring it all together to produce some results: the R programming language.

1.2	Introducing R

R is a statistical programming language, in that it was made for the purpose of performing statistics calculations, but it has grown to be much more through community contributions. As a general-purpose language, R is flexible enough to work with almost any data you can interact with: stored or streaming, images, text, or numbers.

Like most programming languages, it has a specific syntax (way of writing things) that may seem confusing or odd at first, but trust me, you’ll get used to it soon enough. Believe it or not, R is one of the more readable languages.

R is used both professionally and recreationally by a fast-growing number of users.1  Anywhere you find data, there’s a good chance you’ll find someone working with R. A good metric for the popularity of R is the list of professional users of RStudio (the software we’ll use to interact with R), the logos of some of which are shown in figure 1.4.


1 	As of 2017, it was ranked sixth in the IEEE Spectrum’s top 10 programming languages (http://mng.bz/z5sN) and eighth in the TIOBE index of popular programming languages for 2017 (www.tiobe.com/tiobe-index/).




[image: RStudioClients.png]
Figure 1.4  Professional users of R (rstudio.com)




Many other companies use R as part of their data-processing capabilities. Some well-known professional users and their specific uses include the following:2 


2 	See Deepanshu Bhalla, “List of Companies Using R,” Data Science Central, http://mng.bz/qJ66.




	
Genentech — Uses R for data munging and visualization and has ties to the core R developers

	
Facebook — Uses R for exploratory data analysis and experimental analysis

	
Twitter — Uses R for data visualization and semantic clustering

	
City of Chicago — Uses R to build a food-poisoning monitor

	
New York Times — Uses R for interactive features (such as the Dialect Quiz and Election Forecast) and data visualization

	
Microsoft — Uses R for XBox matchmaking

	
John Deere — Uses R for statistical analysis (forecasting crop yields and long-term demand for farming equipment)

	
ANZ Bank — Uses R for credit-risk analysis



R is widely used in academic research of genetics, fisheries, psychology, statistics, and linguistics, among many others. Amateurs have found plenty of fun things to do, such as solving Sudoku puzzles (https://dirk.shinyapps.io/sudoku-solver) and mazes (https://github.com/Vessy/Rmaze), playing chess (http://jkunst.com/rchess), and connecting to online services such as Uber (https://github.com/DataWookie/ubeR).

In this section you’ll learn how R does what it does and how you’ll interact with it. As with any new tool, beginning with a proper understanding of the available features can save a lot of time down the road. To fully appreciate some of the quirks of R, we need to go back to the start.

1.2.1	The origins of R

The predecessor of R was the programming language S (for statistics), developed by John Chambers and colleagues at Bell Labs. This was commercialized in 1993 through an exclusive license as S-PLUS, which was used in a wide variety of disciplines. The community saw significant growth when R was conceived as an open source implementation of the S language, meaning everyday users could both see the underlying structure and build on it. Nonetheless, the new language was backward compatible with S, and much of R’s weirdness that remains can be attributed to that still being the case.

In February 2000, the first stable release of R was released by Ross Ihaka and Robert Gentleman at the University of Auckland in New Zealand. The foundations of R have since been developed by a group of volunteers: the R-core developers and through proposals submitted by the general public. Development also continues in the form of externally produced add-on packages that are officially hosted on the Comprehensive R Archive Network (CRAN, https://cran.r-project.org), of which there were roughly 12,000 by the end of 2017; many more are hosted informally on code-sharing sites such as GitHub.

1.2.2	What R is and what it isn’t

Classifications among programming languages are plentiful and largely obscure. They’re also constantly argued over because their definitions are complex and require a degree in computer science to fully appreciate. Although R (well, S) was originally built for statistics, it can be considered a general purpose language (GPL) in that it isn’t tied to completing just one single task.

Some languages exist purely to achieve a task within some domain (a specific area of interest such as finance, technical drawing, or machine control) and these are referred to as domain-specific languages (DSLs). R is much more flexible than that because you can write your code so that it achieves whichever goal you need.


R is not a DSL. It’s a language for writing DSLs, which is something that’s altogether more powerful.

One person may have a finance data goal in mind, another may be interested in natural language processing, and someone else may be aiming to predict what decisions a customer will make next. The common link between all these is data, but R is so flexible that it provides a capable mechanism to work within each of these domains.

—Joe Cheng, CTO of RStudio



I’m not going to sell R to you; I think it’s a great language that makes many tasks simpler and that has a nice way of doing things, but I won’t try to tell you it’s the only way to solve your specific problem. It may not even be the best way. But by learning a new language, we don’t try to shoehorn a solution into a problem; instead we learn more about how languages work, which helps us better identify how a problem might be solved, even if that means another language is more suitable. Comparing programming languages is like asking which is better, apples or oranges — as usual, it depends, or maybe it doesn’t. A slice of each, please.

What it is

At its most basic level, R is a useful tool for interacting with data. It stores values (data) and functions (code that interacts with data) as variables (names for things) and complex objects (structures). In technical terms, R is an open source, interpreted, general purpose, functional language:


	
Open source — The underlying source code can be freely obtained and (if desired) modified.

	
Interpreted — R doesn’t require compiling your code into a standalone program. Some languages require the code to be built into an executable in order to run it.

	
General purpose — It isn’t restricted to doing just one thing in a particular domain.

	
Functional — It uses functions operating on unchanging data, rather than depending on the current state of the system and modifying data in place.



R can be thought of as a toolbelt. You can add more tools to it if you know where to hang them, you can rearrange them to make them more user-friendly, and you can work with just a few tools or many, depending on your needs. The tools in this sense are packages, logical groups of documented functions (code to perform operations on data) that can be called on to produce some output — a graph, more data, a signal to process, a request to a website, or just about anything.

Without packages (and I include the base packages and those installed by default), R is merely a framework with limited capabilities. The true power comes when additional packages build on this framework to create powerful statistical functions and publication-quality graphics that themselves can be extended and modified as required.

What it isn’t

Having a good toolbelt doesn’t automatically mean you know how to swing a hammer, or that you’ll know the difference between a Phillips and a Torx screw, and having R installed won’t mean that all of a sudden your data analysis procedures will become clear.

R will let you do almost anything to your data, be that a wise choice or a completely unjustified one. In some cases, it will warn you that you’re doing something you possibly don’t want to. At other times, it will silently produce garbage and move on to the next step as if nothing were wrong. That’s not entirely R’s fault — many believe a good programming language should “do what you say, not what you mean” and should let users decide what’s right and what’s wrong.

Because of the way R works (we’ll get to that shortly), it’s not always the fastest method of processing data, though it’s certainly not slow. Depending on your use case, speed may not be an issue at all. Sometimes the overhead of using R is an extra few minutes over some other language, with the trade-off being that R code may be much more usable. Many R packages utilize R’s ability to interact with other languages and strike a balance between what’s processed with R and what’s processed with another, more efficient language (such as C).

1.3	How R works

Some programming languages compile (build) code into an executable program. That has its advantages and disadvantages, but it’s not the way R works. Instead, R is an interpreted language in that the computer works with instructions one at a time (a series of these is a script), and the results from each instruction are presented (returned) to the user.

In order to operate in this way, R implements a read, evaluate, print, loop mechanism (REPL), which does exactly what it sounds like. A diagram of this flow is shown in figure 1.5. R waits patiently for your input, and once it is entered it’s read into the system and evaluated (calculations are performed), the result is printed back to the Console (if there is any), and the entire process loops back to wait for more input.

That may seem like a lot of capability for a language that I just said waits for input before doing anything, and that’s because the R program (R.exe or the R executable you run to start R) is written mainly in C, which is a compiled language (and a very memory efficient one at that). Pressing Enter triggers the C code to perform the REPL operations.

Being an open source language, the source for the code that runs under the hood is available for anyone to inspect. The official source for all versions back to R 0.60.1 is available from https://svn.r-project.org/R/branches, which means you can see how the various components of R have changed over the years if you like. That’s impossible with a proprietary (closed source) program, where the internal workings are only available to those working on it. With open source software, you can even download the entire source, make changes to it, and compile your own personal version.3 


3 	The code is licensed under GPLv2, which means you can do whatever you want to it as long as you maintain the attributions of everyone who has worked on it and don’t sell it for profit or restrict access.
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Figure 1.5  Read, evaluate, print, loop




There’s also a more accessible read-only mirror hosted by Winston Chang at https://github.com/wch/r-source. It’s kept in sync with the official source hourly.

If you haven’t already done so, install R on your computer. Refer to the instructions in appendix A.

At first you’ll issue commands to R one at a time, but eventually you’ll want to be able to tell R to do many things in sequence. This is called a script, and the allusion to the lines an actor will speak is apt. An R script (typically a file ending with .R or .r) is merely a series of commands, usually one per line but that can be split over many lines, to be read in sequence by the R system and processed. This is particularly different than how a spreadsheet file behaves, where the data in its current state is preserved, but not how it got there. Some of the first lines of the script instruct R how to prepare for the upcoming analysis, followed by how to obtain/read the raw data, then how to process it, and finally how and where to save the results. With this workflow, the analysis can be made reproducible, because armed with the raw data and the processing steps, the results can be reproduced.

R alone is sufficient to process an analysis script, which can be passed to the R processor using the command line. On Windows, depending on your exact version and installation path,4  from a command line active in the same directory as your script file, you may be able to use the following command:


4 	Unless you set the $PATH environment variable to search this directory.



C:\Program Files\R\R-3.4.3\bin\R CMD BATCH yourScriptFile.R


On a Linux or Mac system,5  you enter the following at the command line:


5 	Assuming the installation directory is in the $PATH.



R -f yourScriptFile.R


R will start and process the contents of the script file.

If you use R interactively (where you start R yourself and it produces a prompt, awaiting input), you can achieve this same behavior using the source() function:

source(file = "~/yourScriptFile.R")


The tilde (~) in the directory name is a common placeholder for the user’s home directory. Your scripts can be placed in any folder; you just need to tell R where to look.

Although you may be familiar with button menus in Excel, R is a command-based language. That means you’ll be telling R what to do with expressions, pieces of code that perform operations on the data and store the results. Let’s take a moment to see what this looks like and some of the names you’ll encounter; see figure 1.6. Different types of things may be colored (the syntax highlighting); this helps distinguish different parts of your code.


[image: functioncall_bw.png]
Figure 1.6  R code with some terms identified: variable, assignment operator (<-), function, and arguments




Some terms used in figure 1.6 may be new to you:


	
Variable — A name to refer to a piece of data

	
Assignment operator — Function that stores a value in a variable


	
Function — Some code that interacts with data, called (invoked) with an opening ( and a closing ) (parentheses), possibly with arguments


	
Arguments — Options passed to functions, separated by commas, possibly as pairs of argument names and argument values linked by an equals sign (=) — for example, save = TRUE




Working with R in this way (reading commands from a saved file) is certainly possible, but to really get a helping hand along the way, we turn to an additional piece of software that wraps around the R system and provides additional functionality: RStudio.

1.4	Introducing RStudio

Data is stored on your computer (or some device or drive that your computer can connect to), but interacting with it requires some software to read the data, interpret what you want done to it, and write it to some sort of output or storage (either as values, an image, a sound, or something entirely different).

This can take a wide range of forms:


	Viewing the raw, locally stored data in a text editor such as Notepad or emacs

	Displaying formatted data in a spreadsheet or database program such as Excel, Access, or Google Sheets

	Viewing either unencoded or translated JSON data as it passes over the internet with a browser such as Google Chrome or Internet Explorer

	Using programming software to retrieve and manipulate data



All of those have different abilities in terms of displaying and interacting with data. When it comes to using R for interacting with data, a highly sophisticated and powerful interactive development environment (IDE) brings all these abilities together in the form of RStudio. With RStudio, you will be able to view your data in many forms, interact with it, manipulate it, and then store it or distribute it. This IDE features an R-aware text editor for reading/writing scripts, a Console for entering R commands, and best of all, a way to inspect the current state of the Workspace and all the defined variables.

If you haven’t already done so, install RStudio on your computer. Refer to the instructions in appendix A.

1.4.1	Working with R within RStudio

RStudio divides the window into separate panes or sections (see figure 1.76 ). The borders of these can be dragged to expand or contract individual panes, and can be arranged as you prefer by clicking Tools > Global Options > Pane Layout in the menu. Some can also be detached from the main window to be made full-screen.


6 	Adapted from a screenshot originally by PAC2 (www.gnu.org/licenses/agpl.html), via Wikimedia Commons.



The four panes as they appear by default are as follows:


	
Editor — This is where your scripts are written. A script is a series of commands to be executed in order. When you first open RStudio, the Editor will be empty. Click File > New File > R Script to start a new file/script.

	
Console — The R prompt as it would appear in a terminal. This is where you enter commands line by line, followed by pressing Enter. Results returned from R are presented here.

	
Workspace — The values R knows about: your data, or the variables you have defined appear in the Environment tab, and the history of which commands you’ve executed appear in the History tab.

	
Help and Plots — Depending on which tab you have selected, Help or Plots will display either the documentation for a function or dataset, or the most recent plot produced. It also contains the Packages and Files tabs for listing installed packages and files from your computer, respectively.




[image: Rstudio-annotated.png]
Figure 1.7  RStudio panes as they appear in Ubuntu/Linux




There are easy ways to switch between these panes. Ctrl-1 moves the cursor to the Editor pane for writing scripts. Ctrl-2 moves the cursor to the Console pane for interactive commands. While the cursor is on a function, pressing F1 will bring up the Help menu for that function. There are many other keyboard shortcuts available. Try Alt/Option-Shift-K to bring up an extensive cheatsheet.






Alternatives to RStudio

Of course, RStudio isn’t the only way to use R, though I certainly find it to be the most convenient. If working with a command-line interface is more your style (and you can forego the added benefits RStudio offers), then R works fine within a terminal. R can also be hooked into emacs using the Emacs Speaks Statistics (ESS) emacs package. When you first install R under Windows, you’ll also find that RGui is installed, which is a simple graphical interface.

Several alternative graphical interfaces to R are also widely used, such as R Commander and Deducer. For consistency (and because I genuinely believe it to be superior), the remainder of this book assumes you’re working within RStudio.








RStudio lends a helpful hand while working with R, but you can certainly do everything you need to in a terminal alone. Your textual interaction with R in that case would still match what will appear in the Console pane of RStudio, which we’ll focus on now.

RStudio works nicely with Git and SVN right out of the box. I recommend you read up on that from RStudio directly at http://mng.bz/1s4F.

Each time you start an R session (running the R program and working with the R language) either within RStudio or standalone, the Workspace begins empty.7  If you have the option enabled from the settings (on by default), then the files you had open last time you used RStudio will still appear in the Editor pane. The Workspace pane won’t have any objects listed, and the Console will greet you with the following welcome message:


7 	Unless you deliberately set the option to start where you left off by loading the Workspace image.



R version 3.4.3 (2017-11-30) -- "Kite-Eating Tree"    ①  
Copyright (C) 2017 The R Foundation for Statistical Computing
Platform: x86_64-pc-linux-gnu (64-bit)    ②  

R is free software and comes with ABSOLUTELY NO WARRANTY.    ③  
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

  Natural language support but running in an English locale

R is a collaborative project with many contributors.
Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or    ④  
'help.start()' for an HTML browser interface to help.    ④  
Type 'q()' to quit R.    ④  

>    ⑤  
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